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Pre-Installation Checklist 
You can use the following checklist to help you prepare your environment for the deployment of 
Parallels Mac Management for Microsoft SCCM. The Reference column contains links to topics 
describing how to accomplish a corresponding tasks. Most of these topics are located in the 
Installation Requirements (p. 12) and some other sections that follow this one. 

 Category Task Reference 

 
General 
requirements 

Check the requirements for supported 
SCCM, Windows, and OS X versions. 

General Requirements (p. 12) 

 Parallels Proxy .NET Framework 4.0 is required .NET Framework 4.0 (p. 13) 

 Parallels Proxy Proper Distribution Point Role Configuration 
Distribution Point Role Configuration 
(p. 13) 

 Parallels Proxy Verify the IIS settings on the Distribution 
Point Server 

IIS Settings on the Distribution Point 
Server (p. 13) 

 Parallels Proxy 
Check Configuration Manager Boundaries 
Configuration 

Configuration Manager Boundaries 
Configuration (p. 24) 

 Parallels Proxy Configure Windows Firewall Configuring Windows Firewall (p. 25) 

 Parallels Proxy Configure OS X Firewall Configuring OS X Firewall (p. 67) 

 Parallels Proxy Verify that your network environment is 
configured properly Network Configuration (p. 14) 

 Parallels Proxy Date and Time Synchronization check Date and Time Synchronization (p. 
14) 

 
Parallels NetBoot 
Server 

Optional component. Needed for the OS X 
Image Deployment functionality. 

Parallels NetBoot Server 
Requirements (p. 14) 

 

Parallels OS X 
Software Update 
Point 

Optional component. Needed for the OS X 
software update functionality. 

Parallels OS X Software Update 
Point Requirements (p. 15) 

 
Parallels MDM 
Server 

Optional component. Needed for the Apple 
DEP functionality. 

Parallels MDM Server Requirements 
(p. 15) 

 Other 
Verify Reporting Point Role, optional, but 
needed to view reports 

The Reporting Functionality 
Requirements (p. 15) 

 Other Verify Report Viewer, optional, but needed to 
view reports 

The Reporting Functionality 
Requirements (p. 15) 

 Other Review the ports used by Parallels Mac 
Management 

Communication Ports and Protocols 
(p. 16) 

 User rights 

Verify user rights requirements.  

Note: This is a very important step 
to ensure a successful installation of 
Parallels Mac Management. 

User Rights Requirements (p. 17) 

The KB article at 
http://kb.parallels.com/121569 
provides additional information on 
how to set up a service account for 
proper PMM installation. 
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 PKI integration 

Optional, but needed if you would 
like to integrate Parallels Mac 
Management with a Public Key 
Infrastructure (PKI). 

Integrating Parallels Mac 
Management with PKI 

 
 

Installation Requirements 
Before proceeding, please read this section to learn about system requirements for installing Parallels Mac Management 
for Microsoft SCCM.  

The section begins with General Requirements and then describes requirements for installing individual Parallels Mac 
Management components. It concludes with describing communications ports and protocols used by Parallels Mac 
Management.  
 

General Requirements 

Supported SCCM Versions 

Parallels Mac Management supports Microsoft System Center Configuration Manager 2012, 2012 
R2, and newer. Please make sure that you have the latest service pack and critical updates 
installed. 

Supported Windows Versions 

Windows components of Parallels Mac Management follow the same system requirements as the 
Microsoft System Center components.  

Supported OS X Versions 

The following versions of OS X operating system are supported:  

• OS X 10.7 Lion 

• OS X 10.8 Mountain Lion 

• OS X 10.9 Mavericks 

• OS X 10.10 Yosemite 

• OS X 10.11 El Capitan 

• macOS 10.12 Sierra 
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Parallels Configuration Manager Proxy Requirements 

The following subsections describe requirements for a server on which the Parallels Configuration 
Manager Proxy component will be installed. 
 

.NET Framework 4.0 

The server on which Parallels Configuration Manager Proxy will be installed must have the .NET 
Framework 4.0 installed. 
 

Distribution Point Role Configuration 

Verify the Distribution Point role configuration: 

1 In the Configuration Manager console, navigate to Administration / Overview / Site 
Configuration / Servers and Site System Roles.  

2 Select your site in the right pane.  

3 In the Site System Roles pane, right-click the Distribution Point role and then click 
Properties in the context menu.  

4 In the Distribution Point Properties dialog set the following options: 

• On the General tab page, select HTTP or HTTPS in the Specify how client computers 
communicate with this distribution point group. If you'll be using Public Key Infrastructure 
(PKI) for authentication, you need to select HTTPS. The PKI integration is described in the 
Integrating Parallels Mac Management with PKI section (p. 25). 

• If you've selected HTTP, check the Allow clients to connect anonymously option. 
 

IIS Settings on the Distribution Point Server 

To verify the Internet Information Services settings on the Distribution Point Server, do the following: 

1 Open Start > Administrative tools > Internet Information Services (IIS) Manager. 

2 Navigate to Sites / Default Web Site.  

3 Click the Default Web Site and double-click Authentication in the IIS section. 

4 Check that Windows Authentication is enabled. 

5 Click the Default Web Site and double-click Authorization Rules in the IIS section. 

6 Check that authorization is allowed to all users 
 

Configuration Manager Boundaries Configuration 

See Configuring Configuration Manager Boundaries (p. 24) for complete details. 
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Windows and OS X Firewall Configuration 

See Configuring Windows Firewall (p. 25) and Configuring OS X Firewall (p. 67). 
 

Network Configuration 

For details on how your network environment should be configured, see the following KB article: 
http://kb.parallels.com/118518 

In addition, verify that your Mac computers have network access to SCCM site servers. Use the 
traceroute command in OS X and tracert in Windows to verify network access. Access to 
the following servers needs to be checked: 

• The server that will host Parallels Configuration Manager Proxy 

• The Active Directory server 

• The Management Point role server 

• The Distribution Point role server 

Check the IP address of the DNS server in OS X network preferences on a Mac: 

1 In OS X, open System Preferences / Network. 

2 Click the Advanced button. 

3 Click the DNS tab.  

4 In the DNS Servers section, add the DNS server address if it's missing. 
 

Date and Time Synchronization 

Date and time must be synchronized between servers running Configuration Manager, Parallels 
Configuration Manager Proxy, Active Directory, Management Point, Distribution Point, and all Mac 
computers that you want to manage. If date/time is out of sync, the Parallels Mac Client registration 
procedure and Mac management operations (specifically, policy downloading and updating) may 
not work correctly. 
 

Parallels NetBoot Server Requirements 

Parallels NetBoot Server must be installed on a server where the Distribution Point role is installed. 
The server must also meet the following requirements: 

• Must be a PXE service point. 

• Must have WDS installed and running. If both WDS and DHCP are installed on the same server, 
the Do not listen on port 67 option must be selected in the WDS service properties. 

• Must have BITS 4.0 installed. 
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Additionally, the user account that you'll use to configure the Parallels NetBoot Server must have 
sufficient privileges. See the following KB article: http://kb.parallels.com/117937 

Depending on your network topology, you may also need to configure UDP traffic forwarding, so 
DHCP broadcast packets from Mac computers can reach the DHCP server and the NetBoot 
server. For the complete information about setting up the network environment for NetBoot, please 
read the following KB article: http://kb.parallels.com/118518.  

Please also see Communication Ports and Protocols (p. 16) for the list of ports used by NetBoot 
Server. 
 

Parallels OS X Software Update Point Requirements 

In order to install the Parallels OS X Software Update Point component, the following requirements 
must be met: 

• Windows Server Update Services (WSUS) must be installed and configured for local publishing 
of updates. Please see the following page on the Microsoft's website for more info: 

https://msdn.microsoft.com/en-us/library/bb902479 

On the web page, refer to the "To set up the update server for locally-published content" 
section for instructions. 

• A user account must be configured for running the Parallels OS X Software Update Point 
service. The account must have administrative rights on the local sever and must be a member 
of the WSUS Administrators group. 

• The WSUS signing certificate must be deployed and accessible by the user account that will be 
running the Parallels OS X Software Update Point service. Please see the following KB article for 
more information: http://kb.parallels.com/en/123756. 

 

Parallels MDM Server Requirements 

The Parallels MDM Server component must be installed on a server that meets the following 
requirements: 

• Must be located in DMZ. 

• Must be accessible from the server where the Parallels Proxy component will be installed (p. 
13). 

 

The Reporting Functionality Requirements 

The Reporting Point role and report viewer described below are not required in order to install 
Parallels Mac Management, but are needed for the reporting functionality to work. 
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Reporting Point Role 

To verify that the Reporting Point role is installed: 

1 In the Configuration Manager console, navigate to Administration / Overview / Site 
Configuration / Servers and Site System Roles.  

2 Verify that the Reporting services point role exists. 

3 Navigate to Monitoring / Reporting / Reports.  

4 Right-click any of the available reports and check that the Run item is available in the context 
menu. 

Report Viewer 

To verify that the Report Viewer is installed:  

1 In the Configuration Manager console, click Start > Control Panel > Programs and Features.  

2 Verify that Microsoft Report Viewer Redistributable is installed. 
 

Communication Ports and Protocols 

Communication ports used by Parallels Mac Management should not be used by other programs. 
Please review the following table and make sure that the ports listed are available. Please note that 
the table doesn't include ports used by the standard System Center Configuration Manager 
services and by standard Windows services. 

Program TCP UDP Platform Required Notes 

Configuration Manager 
Proxy 

pma_isv_proxy_service.exe 

8760, 
8761 

 Windows Required 

The default ports 8760 and 
8761 can be changed if 
needed using the 
Configuration Manager Proxy 
configuration utility. 

NetBoot Server 

pma_netboot_service.exe 

bootpd (DHCP) 

 67, 68 Windows Optional Required for the NetBoot 
Server functionality. 

NetBoot Server 

pma_netboot_service.exe 

tftpd (TFTP) 

 69 Windows Optional Required for the NetBoot 
Server functionality. 

NetBoot Server 

pma_netboot_service.exe 

HTTPD (Web) 

80  Windows Optional Required for the NetBoot 
Server functionality. 

SSH server 22  Mac Optional 
Required for the Network 
Discovery functionality. 
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VNC server 5900  Mac Optional Needed to accept VNC 
connections on a Mac. 

Mac client 8000  Mac Required 

Required for Parallels Mac 
Client to accept incoming 
connection from Parallels 
Configuration Manager Proxy. 

Additionally, you must enable RPC ports to allow WMI/RPC traffic to pass through. RPC ports can 
be opened by enabling the Group Policy firewall exception as described below: 

1 Edit the Group Policy object (GPO), which is used to manage Windows Firewall settings in your 
organization.  The GPO can be edited using the Group Policy Object Editor snap-in 
(gpedit.msc). 

2 In the GPO Editor, navigate to Computer Configuration / Administrative Templates / 
Network / Network Connections / Windows Firewall.  

3 Open either the Domain Profile or Standard Profile, depending on which profile you use.  

4 Right-click the Windows Firewall: Allow inbound remote administration exception item and 
choose Edit. 

5 Select the Enabled option and click OK. 
 

User Rights Requirements 
To install, configure, and run Parallels Mac Management for Microsoft SCCM, you will need to 
create and configure user accounts with sufficient privileges to perform their respective tasks. 
 

Permissions for Running Parallels Proxy Configuration Wizard 

A user that will be running the Parallels Configuration Manager Proxy Configuration Wizard must 
have specific permissions. This section describes these permissions. 

The material presented in this section considers two possible scenarios: 

• The Parallels Configuration Manager Proxy is configured for the first time. 

• The Proxy has been previously configured and you want to reconfigure it using a different user 
account. 

Some of the instructions apply to the first scenario only and some apply to both. Simply follow the 
instructions that correspond to your configuration and skip those that don't. 

Note: When creating (or choosing) a user account that you will use to configure Parallels Configuration 
Manager Proxy, consider the following. If Parallel Configuration Manager Proxy and Active Directory will 
run on different computers, the described permissions must be granted directly to the user or to a 
custom group (not a built-in group, like Administrators) to which the user belongs. If Parallels Proxy and 
AD will run on the same server, you can add the user to a built-in group. 
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Create a Domain User 

The user configuring Parallels Configuration Manager Proxy must be a domain user. You can 
choose an existing domain user or create a new one. 
 

Local Administrator Rights 

The user must have administrative rights on the computer where the Parallels Configuration 
Manager Proxy will be installed: 

1 Log into the computer that will run Parallels Proxy. 

2 Open Server Manager and navigate to Configuration / Local Users and Groups / Groups. 

3 Right-click the Administrators group and select Properties in the context menu. 

4 In the Select Users dialog, click Add and add the domain user you've created earlier. Click OK 
and then OK again. 

 
 

DCOM Remote Activation Permission 

The user must have the DCOM Remote Activation permission: 

1 On the computer where the SMS Provider is installed, click Start > Administrative Tools > 
Component Services. 

2 In the Component Services window, navigate to Console Root / Component Services / 
Computers / My Computer / DCOM Config. Scroll down to Windows Management and 
Instrumentation, right-click it, and then click Properties in the context menu. 

3 Click the Security tab. The Launch and Activation Permissions section will have either the 
Use Default or the Customize option selected depending on your server configuration.  

4 If the Customize option is selected, click the Edit button, then add the user to the list and 
grant the user the Remote Activation permission. You may skip the remaining steps. 

5 If the Use Default option is selected, close this window and continue with the following steps. 

6 In the Component Services window, navigate to Console Root / Component Services / 
Computers. Right-click My Computer and click Properties in the context menu. 

7 Click the COM Security tab. 

8 In the Launch and Activation Permissions section, click Edit Default. 

9 Add the user to the list and grant the user Remote Activation permission. 

 
 

Administrative Rights in SCCM 

The user must have full administrator rights in Configuration Manager: 
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1 Log into the computer running the Configuration Manager console. 

2 In the Configuration Manager console, navigate to Administration / Overview / Security. 

3 Right-click Administrative Users and click Add User or Group in the context menu. 

4 In the Add User or Group dialog, click Browse, find the domain user that you created earlier, 
and then click OK. The user will appear in the User or group name field in the Add User or 
Group dialog. 

5 Click the Add... button in the Assigned security roles section. 

6 In the Available security roles list, select Full Administrator and click OK. 

7 Click OK to close the Add User or Group dialog. 

 
 

Permissions in Active Directory 

The user must have the necessary permissions in Active Directory. These permissions are required 
to create Parallels Mac Management-specific containers in AD and to manipulate data in these 
containers. 

To grant the permissions: 

1 Open ADSI Edit by clicking Start > Administrative Tools > ADSI Edit. 

2 Verify that the following container exists: DC=<domain> / DC=<com> / CN=System / 
CN=ParallelsServices. 

3 If the container above doesn't exist, grant the user the Create All Child Objects and Read 
permissions on the CN=System container. When granting these permissions to the user, apply 
it to This object and all descendant objects. 

4 If the container exists, do the following: 

• Make sure the user have Read, Write, and Create All Child Objects permissions on it. 

• Make sure the user has the Full Control permission on the CN=ParallelsServices / 
PmaConfigMgrProxy-<site-code> container. 

5 Verify that the DC=<domain> / DC=<com> / CN= Program Data / CN=Parallels container 
exists. 

6 If the container above doesn't exist, grant the user the Create All Child Objects and Read 
permissions on the CN=Program Data container. When granting these permissions to the user, 
apply it to This object and all descendant objects. 

7 If the CN=Parallels container exists, continue with the following steps. 

8 Verify that the CN=Parallels / CN=Parallels Management Suite container exists. If it doesn't, 
grant the user the Create All Child Objects and Read permissions on CN=Parallels container. 

9 If the CN=Parallels / CN=Parallels Management Suite container exists, make sure that the user 
has Read, Write, and Create All Child Objects permissions on it. 
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Permissions to Read/Write Service Principle Name 

The user must have permissions to read/write Service Principle Name. These permissions are 
required for the RBAC functionality. The Parallels Configuration Manager Proxy service account 
must have a registered Service Principle Name (SPN) for Kerberos connections. By default (with 
some exceptions) users are not permitted to register SPN to their own accounts. 

To grant the permissions: 

1 Open ADSI Edit by clicking Start > Administrative Tools > ADSI Edit. 

2 Locate the required object: 

• If you specify a user as a service account during the configuration, you should locate this 
user object. 

Note: The user object you select in this step must be the object of the user that will be used to run the 
service, not of the user that will be used to configure it. If you'll be using the same user to configure and 
to run the Parallels Configuration Manager Proxy service, then select the domain user object that you 
created in previous steps. 

• If you choose LocalSystem as a service account during the configuration, you should locate 
the computer object you are running Proxy on. 

3 Right-click the object, select Properties in the context menu, and then click the Security tab in 
the user properties dialog. 

4 Add the user that will be configuring the Parallels Configuration Manager Proxy to the Group or 
user names list and then click the Advanced button. 

5 In the Advanced Security Settings dialog, select the user that you added to the list in the 
previous step and click the Edit button. 

6 In the Permission Entry dialog, click the Properties tab. 

7 In the Apply to drop-down list, select This object only. 

8 In the Permissions list, select the Read servicePrincipalName and Write 
servicePrincipalName permissions. 

9 Close all dialogs. 
 

Microsoft SQL Server Permissions 

The user must have necessary permissions in Microsoft SQL Server. These permissions are 
needed to create and use a database storing the Parallels Mac Management data. 

To grant the user the right to create databases in SQL Server, assign the user to the dbcreator role 
as follows: 

1 Run SQL Server Management Studio by clicking Start > All Programs > Microsoft SQL 
Server 2008 R2. 
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2 Connect to the SQL server. 

3 Verify that the user that will be configuring Parallels Configuration Manager Proxy exists in 
Security / Logins. If the user doesn't exist, add the user to the Logins list. To do so, right-click 
Logins and then click New Login. Select Windows authentication and specify the Login 
name as domain\username (or click Search to search for the user). Click OK when done. 

4 Navigate to Security / Server Roles, right-click the dbcreator role, and then click Properties 
in the context menu. 

5 In the Server Role Properties dialog, click Add... 

6 In the Select Logins dialog, click Browse to search for and select the user that will configure 
Parallels Configuration Manager Proxy. 

7 Close all dialogs. 

If you have previously configured Parallels Mac Management Proxy on this site, then the Parallels 
Mac Management database should already exist in this SQL Server instance. To verify this, connect 
to the SQL Server and look for a database named "PMM_<side-code>" (where <site-code> is your 
SCCM site code). If a database with such a name exists, then perform the steps below. If the 
database doesn't exist, skip to the next section. 

Assuming that the "PMM_<side-code>" database exists, grant the user the necessary permissions 
on it as follows: 

1 In Microsoft SQL Server Management Studio, navigate to Security / Logins. 

2 Right-click the user that will configure the Parallels Proxy and click Properties. 

3 In the left pane, click User Mapping. 

4 In the right pane, select the "PMM_<side-code>" database (select the Map checkbox) and then 
select the following roles in the Database role membership list: 

• db_datareader 

• db_datawriter 

• db_ddladmin 

• db_securityadmin 

• public 

5 Click OK. 

 
 

Administrative Rights in Authorization Manager 

If Parallels Configuration Manager Proxy has been configured previously and the Authorization 
Store exists, the user configuring the Parallels Proxy must be assigned to the Administrator role in 
Authorization Manager.  

To assign the user to the Administrator role: 
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1 Start Microsoft Management Console (run mmc.exe). 

2 In the MMC, click File > Add/Remove Snap-in... 

3 Select Authorization Manager in the Available snap-ins list and click Add. 

4 Click OK. 

5 Right-click Authorization Manager and then click Open Authorization Store... 

6 Select Active Directory or Active Directory Application Mode (ADAM) and click Browse. 

7 Select CN=Authorization Store,CN=Parallels Management Suite,CN=Parallels,CN=Program 
Data, DC=<domain>,DC=<com>. 

8 Click OK and OK again to close the dialogs. 

9 Expand Authorization Manager in the left pane, right-click Authorization Store, and then click 
Properties. 

10 Click the Security tab. 

11 In the Authorization Manager user role drop-down list, select Administrator. 

12 Click Add and add the user that will configure Parallels Proxy to the Users and groups that 
are assigned to this role list. 

13 Click OK to save the changes and close the dialog. 

 
 

Permissions for Running Parallels Proxy Service 

Parallels Configuration Manager Proxy runs as a service in Windows. The user account under which 
it runs must have specific permissions. This article describes these permissions. 

Note: When creating (or choosing) a user account that will be used to run the Proxy service, consider the 
following. If Parallel Configuration Manager Proxy and Active Directory will run on different computers, 
permissions must be granted directly to the user or to a custom group (not a built-in group, like 
Administrators) to which the user belongs. If the Proxy and AD will run on the same server, you can add 
the user to a built-in group. 

The user configuring Parallels Configuration Manager Proxy must be a domain user. You can use 
and existing domain user or you can create a new one. 

The user must be a local administrator on the computer running the Parallels Configuration 
Manager Proxy. 

The user must have the DCOM Remote Activation permission. To grant the permission: 

1 On the computer where the SMS Provider is installed, click Start > Administrative Tools > 
Component Services. 
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2 In the Component Services window, navigate to Console Root / Component Services / 
Computers / My Computer / DCOM Config. Scroll down to Windows Management and 
Instrumentation, right-click it, and then click Properties in the context menu. 

3 Click the Security tab. The Launch and Activation Permissions section will have either the 
Use Default or the Customize option selected depending on your server configuration. 

4 If the Customize option is selected, click the Edit button, then add the user to the list and 
grant the user the Remote Activation permission. 

5 If the Use Default option is selected, close this window and continue with the following steps. 

6 In the Component Services window, navigate to Console Root / Component Services / 
Computers. Right-click My Computer and click Properties in the context menu. 

7 Click the COM Security tab. 

8 In the Launch and Activation Permissions section, click Edit Default. 

9 Add the user to the list and grant the user Remote Activation permission. 

The user must have full administrator rights in Configuration Manager. To set the rights: 

1 Log into the computer running the Configuration Manager console. 

2 In the Configuration Manager console, navigate to Administration / Overview / Security. 

3 Right-click Administrative Users and click Add User or Group in the context menu. 

4 In the Add User or Group dialog, click Browse, find the domain user that you created earlier, 
and then click OK. The user will appear in the User or group name field in the Add User or 
Group dialog. 

5 Click the Add... button in the Assigned security roles section. 

6 In the Available security roles list, select Full Administrator and click OK. 

7 Click OK to close the Add User or Group dialog. 

8 If the CN=System / CN=ParallelsServices / CN=PmaConfigMgrProxy-<site-code> container 
exists in Active Directory, the user must have Read, Write, and Create All Child Objects 
permissions on it. 

 

Permissions for Running Parallels OS X Software Update Point 

A user account must be configured for running the Parallels OS X Software Update Point service. 
The account must meet the following requirements: 

• Have administrative rights on the local server. 

• Be a member of the WSUS Administrators group.  

For additional information, please see Parallels OS X Software Update Point Requirements (p. 
15). 
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Configuring Configuration Manager Boundaries 
Before deploying Parallels Mac Client on Mac computers, you need to configure Configuration 
Manager Boundaries. Boundary is a network location on the intranet that can contain one or more 
Mac computers that you want to manage. Mac computers are assigned as clients to SCCM 
according to the boundaries configured in the Configuration Manager console.  

Note: Please make sure that you complete all of the steps described below or you will not be able to 
enroll your Mac computers in Configuration Manager. 

Create a Boundary 

To create new (or modify an existing) boundary: 

1 In the Configuration Manager console, navigate to Administration / Overview / Hierarchy 
Configuration / Boundaries. 

2 To create a new boundary, right-click Boundaries and click Create Boundary. To modify an 
existing boundary, right-click it and select Properties from the context menu. 

3 On the General tab page, select the desired boundary type and specify the value(s) in such a 
way that IP addresses of your Mac computers lie within this boundary. Please note that 
Parallels Mac Management supports the following boundary types: 

• IP subnet 

• IP address range 

• Active Directory site 

Create a Boundary Group 

After you create a boundary, you need to create a boundary group, add the boundary to it, and 
associate a site system server with the group. 

To create a new or modify an existing boundary group: 

1 In the Configuration Manager console, navigate to Administration / Overview / Hierarchy 
Configuration / Boundary Groups. 

2 To create a new boundary group, right-click Boundary Groups and click Create Boundary 
Group. To modify an existing boundary, right-click it and select Properties from the context 
menu. 

3 On the General tab page, specify a boundary name and optional description. 

4 Click the Add button and select a boundary from the list. Click OK. 

5 On the References tab page, select the Use this boundary group for site assignment 
option.  
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6 Select your site in the Assigned site drop-down box. 

7 In the Content location section, click the Add button and select a site system server to 
associate with this boundary group. Click OK. 

8 Click OK to save the boundary group and close the window. 
 

Configuring Windows Firewall 
To enable Parallels Configuration Manager Proxy and Parallels NetBoot Server network 
communications, their executable files must be added to the Windows firewall exception list.  

The name and path of the Configuration Manager Proxy executable is: 

%ProgramFiles(x86)%\Parallels\Parallels Mac Management for Microsoft 
SCCM\pma_isv_proxy_service.exe 

The name and path of the NetBoot Server executable is: 

%ProgramFiles(x86)%\Parallels\Parallels Mac Management for Microsoft 
SCCM\pma_netboot_service.exe 

To add the executables to the Windows firewall exception list, open the Windows Control Panel 
and click (or double-click) Windows Firewall. Add the .exe files to the list of programs allowed 
through Windows Firewall.  

For the list of ports used by Parallels Mac Management for Microsoft SCCM, see Services, Ports 
and Protocols (p. 16). 
 

Integrating Parallels Mac Management with PKI 
Parallels Mac Management for Microsoft SCCM can be directly integrated with Public Key 
Infrastructure (PKI). Such integration enables the use of certificates for advanced user 
authentication and secure access to SCCM. 

If you would like to integrate Parallels Mac Management with PKI, you need to complete the steps 
described in the following subsections prior to installing Parallels Mac Management. If not, you can 
skip this section and continue with Installing Parallels Mac Management for Microsoft SCCM 
(p. 29). You can perform the PKI integration at any time later by completing the steps described in 
this section and then reconfiguring Parallels Mac Management. The reconfiguration involves running 
the Configuration Manager Proxy Configuration Wizard (described later in this guide) and 
specifying the appropriate options on the Parallels Client certificate management settings page 
of the wizard. 
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PKI Integration Overview 

The integration of Parallels Mac Management for Microsoft SCCM with PKI enables the following 
security features: 

• Obtaining security certificates for assigned Mac computers from a certificate authority trusted 
by SCCM. 

• Securing communications between Mac computers and SCCM by using mutual authentication 
and encrypted data transfers. 

Parallels Mac Management supports certificate authority certificates on the following versions of 
Windows: 

• Windows Server 2008  

• Windows Server 2008 R2 

• Windows Server 2012 

• Windows Server 2012 R2 (or newer) 

Note: Integration is provided for Microsoft Certificate Services only. No third-party certificate services are 
supported 

 

What This Section Does Not Cover 

The material presented in this section does not cover any of the concepts behind PKI design and 
implementation. It describes what needs to be done in order to integrate Parallels Mac 
Management with an existing PKI installation. If you would like to learn more about PKI, you can 
read the Securing Public Key Infrastructure (PKI) content on the Microsoft's website, which can 
be found at the following URL: https://technet.microsoft.com/en-
us/library/dn786443.aspx 
 

Creating Certificate Templates for Parallels Proxy and Mac Computers 

To enable Mac connectivity to HTTPS-enabled SCCM infrastructure, a Mac must obtain digital 
certificates from the certificate authority (CA) trusted by SCCM. Digital certificates secure the 
communication between Mac computers and the Configuration Manager site by using mutual 
authentication and encrypted data transfers. 

Creating a Certificate Template for Parallels Configuration Manager Proxy 

To create a certificate template: 

1 In Windows, click Start > Administrative Tools > Certification Authority. 

2 Expand the tree of your Certification Authority.  
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3 Right-click Certificate Templates and click Manage. The Certificate Template Console 
opens. 

4 In the template list, locate Web Server, right-click it and then click Duplicate Template. The 
Properties of New Template dialog opens.  

5 On the Compatibility tab page, select Windows Server 2008 as Certification Authority and 
Windows 7 / Server 2008 R2 as Certificate recipient. 

6 On the General tab page, specify a template name. 

7 On the Cryptography tab page: 

• Set Minimum key size to 2048. 

• Set Provider Category to Legacy Cryptographic Service Provider. 

• Set Algorithm to Determined by CSP. 

8 On the Request Handling tab page, select the Allow private key to be exported option. 

9 On the Subject Name tab page, select the Supply in the request option and the Use subject 
information from existing certificates for autoenrollment renewal requests option. 

10 On the Extension tab page, double-click the Application Policies extension, then click Add 
and select Client Authentication from the list. Click OK and then OK again. The Client 
Authentication description should appear in the Description of Application Policies list. 

11 On the Security tab page, add the server that hosts Parallels Configuration Manager Proxy and 
the user account under which the Proxy is running. Grant them Enroll and Autoenroll 
permissions. Please note that if the Proxy is running under the LocalSystem account, then you 
only need to add the computer name. 

12 Click OK to close the Properties of New Template dialog. 

13 Close the Certificate Template Console. 

14 Back in the Certification Authority window, right-click Certificate Templates again and 
choose New > Certificate Template to Issue. 

15 Select the template that you created in the previous steps and click OK to enable it. 

Creating a Certificate Template for Mac Computers 

To create a certificate template: 

1 In Windows, click Start > Administrative Tools > Certification Authority. 

2 Expand the CA tree, right-click Certificate Templates and click Manage. 

3 The Certificate Template Console opens. 

4 In the template list, locate Workstation Authentication, right-click it and then click Duplicate 
Template in the context menu. 

5 On the Compatibility tab page, select Windows Server 2008 as Certification Authority and 
Windows 7 / Server 2008 R2 as Certificate recipient. 
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6 On the General page, specify a template name. 

7 On the Cryptography tab page: 

• Set Minimum key size to 2048. 

• Set Provider Category to Legacy Cryptographic Service Provider. 

• Set Algorithm to Determined by CSP. 

8 On the Request Handling tab page, select the Allow private key to be exported option. 

9 On the Subject Name tab page, select the Supply in the request option. The Certificate 
Templates message box will pop. Click OK to close it. 

10 On the Subject Name tab page, select Use subject information from existing certificates 
for autoenrollment renewal requests option. 

11 On the Extension tab page, make sure that Client Authentication is displayed in the 
Description of Application Policies list. If it's not, add it. 

12 On the Security tab page, add the server that hosts Parallels Configuration Manager Proxy and 
the user account under which the Proxy is running. Grant them Enroll and Autoenroll 
permissions. If the Proxy is running under the LocalSystem account, then you only need to add 
the computer name. 

13 Click OK to close the Properties of New Template dialog. 

14 Close the Certificate Templates Console. 

15 In the Certification Authority window, right-click Certificate Templates and click New > 
Certificate Templates to Issue. 

16 In the Enable Certificate Templates dialog, select the template that you created in the 
previous steps and click OK to enable it. 

 

Creating a Security Group 

Create a dedicated security group and grant it the rights to request certificates from the certificate 
authority. The following users must be added to this group:  

• An administrator who will be installing and configuring Parallels Configuration Manager Proxy. 
This is needed because the Parallels Proxy configuration utility will request the certificate for the 
Proxy. 

• An account under which the Parallels Configuration Manager Proxy service will run. This is 
needed because the Proxy will be requesting certificates for Mac computers. 

 

Handling Expired Certificates 

Parallels Proxy can automatically handle a situation when digital certificates issued to Mac 
computers or the Parallels Proxy itself expire. It can also determine if a signing certificate of the 
certification authority (CA) has changed, thus invalidating current certificates. The following 
describes how Parallels Proxy handles these events: 
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• When Parallels Proxy needs to communicate with a Mac, it first examines the digital certificate 
of the Parallels Mac Client running on it. If a certificate has expired or will expire soon, it will 
automatically renew the certificate. 

• Parallels Proxy will also check if the signing certificate of the currently used certification authority 
matches the one used by the Parallels Mac Client's certificate. If it's not, a new certificate will be 
issued for the Parallels Mac Client using the current CA. 

• Parallels Proxy validates its own digital certificate at preset intervals. If a certificate is not valid, a 
log entry is created in the isv_proxy_service.log file and in the Windows event log. The 
relevant log entries can be viewed in the %WINDIR%\Logs\pma_isv_proxy_service.log 
file and in the Windows event viewer (eventvwr) by navigating to Windows Logs > Application 
and searching for "Parallels Mac Management for Microsoft SCCM" entires. 

Note: Parallels Mac Management v5.0 does not support automatic renewal of the Parallels Proxy 
certificate. This functionality may become available in a later version of Parallels Mac Management. For 
the instructions on how to renew the certificate manually, please read 
http://kb.parallels.com/en/123836. 

 

This chapter will take you through the installation of Parallels Mac Management for Microsoft 
SCCM. 
 

Installation Overview 
Parallels Mac Management for Microsoft SCCM consists of several components, which are 
installed in Windows using the same installation wizard (except Parallels Mac Client, which is 
installed in OS X). If you are installing the components on different servers, run it on each server and 
select only the component(s) that you want installed on that particular server. 

Please note that Parallels Configuration Manager Proxy must be installed on each primary SCCM 
site. If you have secondary sites, you can choose from the following installation options: 

• Installing Parallels Configuration Manager Proxy on the primary and secondary sites. This option 
allows you to better manage bandwidth utilization between Mac computers, the distribution 
point, and the management point. You must install Parallels Configuration Manager Proxy on 
the primary site and then on a secondary sites (in that order). 

• Installing Parallels Configuration Manager Proxy on the primary site only. If you use this option, 
Mac computers will communicate directly with the Configuration Manager Proxy installed on the 
primary site. 

Installation and Configuration 
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Before running the installation wizard, please make sure that you have read Installation 
Requirements (p. 12) for each component that you are planning to install. 
 

Running the Setup Wizard 
The Parallels Mac Management for Microsoft SCCM Setup wizard is used to install Parallels 
Mac Management. When you run the wizard, you need to select the components you wish to install 
on a given server. The rest of the installation is mostly automatic. 

When installing Parallels Mac Management for the first time, you must install at least Parallels 
Configuration Manager Proxy and the Configuration Manager Console Extension (but necessarily 
both on the same Windows machine). Other components are optional, so you should install them 
only if you want to use the functionality that they provide. You should also decide in advance on 
which servers you want to install individual components and then run the setup wizard on each 
server selecting only the component(s) you want to install. 

To install Parallels Mac Management: 

1 Run the Parallels Mac Management for Microsoft SCCM Setup Wizard. 

2 Read the info on the Welcome page and click Next. 

3 On the License Agreement page, read the End-User License Agreement. If agreed with the 
terms, select I accept the terms in the license agreement and click Next. 

4 On the Select Components page, select the components you wish to install from the following 
list: 

• Parallels Configuration Manager Proxy. A Windows service application that acts as a 
proxy between SCCM and Mac computers. This component is required for Parallels Mac 
Management to work. 

• Configuration Manager Console Extension. This component consists of a set of dynamic 
libraries that extend the Configuration Manager console to provide a graphical user interface 
enabling you to manage Mac computers. The component must be installed on the 
computer where the Configuration Manager console is running. 

• NetBoot Server. Enables Mac computers to boot from a network. You need to install this 
component if you plan to deploy OS X images on Mac computers. 

• OS X Software Update Point. Allows you to manage Apple software updates (patches) for 
OS X using the native SCCM functionality. The component must be installed on a server 
where Windows Server Update Services (WSUS) is installed. 

• MDM Server. Select this component if you plan to deploy and enroll new Mac computers in 
SCCM using the Apple Device Enrollment Program (DEP). 

• Click Next and then click Install to begin the installation. 

5 Wait for the installation to finish. 
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8 Right-click the Configuration Manager Proxy certificate, point to All Tasks, and then click 
Manage Private Keys. 

9 In the Permissions for Configuration Manager Proxy private keys dialog, verify that the user 
(or a group to which the user belongs) has Read access to the certificate's private key. 

 

Migrating Configuration Manager Proxy 

This section describes how to migrate the Parallels Configuration Manager Proxy to another server 
on the same Configuration Manager site. 

To migrate the Parallels Configuration Manager Proxy: 

1 Export the Proxy certificate from the Windows Certificate Store on the current server. 

2 Uninstall the Proxy from the current server. 

3 Import the certificate into the Windows Certificate Store on the new server. 

4 Install the Proxy on the new server. 

The following describes the certificate export and import procedures. The Proxy installation and 
uninstallation procedures are described in Install Parallels Mac Management for Microsoft 
SCCM (p. 29). 

Exporting Certificate from Certificate Store 

To export a certificate: 

1 Open the Microsoft Management Console (mmc.exe). 

2 In the console, click File > Add/Remove Snap-in to open the Add or Remove Snap-ins 
dialog. 

3 Click Certificates in the Available snap-ins list. 

4 Click the Add button. Select the Computer account option and click Next. 

5 On the Select Computer page, select Local computer and click Finish. Click OK to close the 
Add or Remove Snap-ins dialog. 

6 In the Microsoft Management console, click Console Root / Certificates(Local computer) / 
Personal / Certificates. 

7 Right-click the Parallels Configuration Manager Proxy certificate and then click the All Tasks > 
Export... option in the context menu. The Certificate Export Wizard opens. 

8 Click Next on the Welcome page. 

9 Select Yes, export the private key and click Next. 

10 On the Export File Format page, select the following options: 

• Personal Information Exchange - PKCS #12 (.PFX) 

• Include all certificates in the certification path if possible 
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• Export all extended properties 

11 Click Next. 

12 On the Password page, type and confirm a password (you’ll be asked for it when importing the 
certificate on the new server). Click Next. 

13 Type a path and filename for the target certificate file (e.g. C:\sccm_proxy.pfx) and click 
Next. 

14 Review the export summary and click Finish to complete the wizard. 

15 Copy the certificate file to the server where you want to migrate the Configuration Manager 
Proxy. 

Importing Certificate into Certificate Store 

To import a certificate: 

1 Open the Microsoft Management Console (mmc.exe). 

2 In the console, click File > Add/Remove Snap-in to open the Add or Remove Snap-ins 
dialog. 

3 Click Certificates in the Available snap-ins list. 

4 Click the Add button. Select the Computer account option and click Next. 

5 On the Select Computer page, select Local computer and click Finish. 

6 Click OK to close the Add or Remove Snap-ins dialog. 

7 In the Microsoft Management console, click Console Root / Certificates(Local computer). 

8 Right-click the Personal node and then click the All Tasks > Import... item in the context 
menu. The Certificate Import Wizard opens. 

9 Click Next. 

10 On the File to Import page, click the Browse button and select the “.pfx” certificate file that 
you exported earlier (make sure to change the filter in the Open dialog to .pfx). Click Next. 

11 On the Password page, type the password that you entered when you exported the certificate 
and select the Mark this key as exportable... option. 

12 Click Next. 

13 On the Certificate Store page, select the Place all certificates in the following store option. 
Make sure that the Certificate store field is set to Personal (if it doesn't, click the Browse 
button and select Personal from the list). 

14 Click Next. 

15 Review the import summary and click Finish to complete the wizard. 

16 Install and configure Configuration Manager Proxy on the new server by running the Parallels 
Mac Management for Microsoft SCCM installer. 



43 
 

Installation and Configuration 
 

17 Mac computers will automatically discover the new Parallels Configuration Manager Proxy and 
will update their own local Proxy connection records. For more information, please see 
Updating Proxy Connection URL (p. 68). 

 

Upgrading Parallels Mac Management 

To upgrade Parallels Mac Management to a newer version, you need to uninstall the current 
version and then install a new one.  

To run the uninstaller, go to Control Panel > Programs > Uninstall a program and uninstall the 
Parallels Mac Management for Microsoft SCCM program. If Parallels Mac Management 
components are installed on different servers, you need to uninstall each component individually. 
When done, install the new version of Parallels Mac Management for Microsoft SCCM. Please note 
that after upgrading Parallels Mac Management, you need to upgrade the Parallels Mac Client on 
each managed Mac. See Upgrading Parallels Mac Client (p. 69) for more information. 

 



 

 

This chapter explains how Parallels Mac Management licensing works and how to obtain a license 
and use it to activate a Parallels Mac Management installation.  

You can read more about Parallels Mac Management licensing in the Parallels Mac Management 
for Microsoft SCCM Licensing Guide, which is available for reading and downloading on the 
Parallels website. 

In This Chapter 

Parallels Mac Management Licensing ..................................................................... 44 
Activate Parallels Mac Management ........................................................................ 51 
 
 

Parallels Mac Management Licensing 
Parallels Mac Management for Microsoft SCCM is licensed on a per managed Mac basis. The 
number of individual licenses in your subscription denotes the number of Mac computers that you 
can manage in SCCM. 

You license Parallels Mac Management with a prepaid subscription, which works as follows: 

• A subscription is purchased for a predefined period of time. 

• A subscription can include any number of individual licenses (the maximum number of Mac 
computers that you can manage). 

• Support is included in the cost of the subscription. 

No matter how many licenses in your subscription, you'll receive a single license key. A license key 
can be used to activate a single installation of Parallels Mac Management. If you need to activate 
several Parallels Mac Management installations to work simultaneously, you need multiple license 
keys. 

 
 

Purchasing a Subscription 

To purchase a Parallels Mac Management subscription, please contact the Parallels Sales team or 
a Parallels Partner/Reseller. 
 

C H A P T E R  3  

Licensing and Activation 
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Obtaining a Trial License 

If you would like to evaluate Parallels Mac Management, you need to obtain a trial license from the 
Parallels Sales team or a Parallels Partner/Reseller. 
 

Create a Parallels Account 

Parallels My Account is a web application that enables Parallels customers (consumers and 
organizations) to view and manage licenses for various Parallels products. The instructions below 
describe how to quickly get started with Parallels My Account. 

You can create an account for your company or organization when you first register with Parallels 
My Account, or after you already created a private account. 

Create a Parallels account from scratch 

If you are a new customer and don't have a Parallels account yet, you can create one for yourself 
and your organization as follows: 

1 Visit Parallels My Account at https://account.parallels.com 
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Activate Parallels Mac Management 
After you registered your subscription in Parallels My Account, you can activate Parallels Mac 
Management using your license key. 

You can use the online or the offline activation method. The method you choose depends on the 
following: 

• If the server on which you have Parallels Proxy installed has limited or no Internet access, you 
must use the offline activation method. 

• If the server has Internet access, you can use the online activation method. 

The subsequent sections describe each method in detail. 
 

Activate Online 

Note: During online activation, Parallels Proxy needs to communicate with the Parallels Licensing Server 
at https://pmm.parallels.com. You need to make sure that the Parallels Proxy server can access this 
resource. If this requirement cannot be met, you will have to use the offline activation method as 
described in the section that follows this one.   

To activate Parallels Mac Management using the online activation method: 

1 Open the Configuration Manager console. 

2 Navigate to Administration / Overview / Parallels Mac Management / Licenses. 

3 Right-click your site in the Licenses list and choose Activate license. 

4 The Parallels Mac Management - Activate License dialog opens. 

5 Input your license key and select the Activate online option. 

6 Click Next. 

7 Parallels Mac Management connects to the Parallels Licensing Server and verifies the key.  

8 If the key is valid, the license information is displayed on the screen. Review the information and 
click Activate. 

9 On successful activation, the display value of the License status column in the Licenses list in 
the SCCM console changes to Activated. 

Your Parallels Mac Management installation is activated and the activation information is added to 
Parallels My Account. 
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Activate Offline 

If the server on which you have Parallels Proxy installed has limited or no Internet access, you can 
use the offline activation method described below. 

Important: Before using offline activation, you must contact your Parallels sales representative or a sales 
engineer and request to enable this functionality in Parallels My Account. By default, this functionality is 
disabled. 

To activate Parallels Mac Management:  

1 Open the Configuration Manager console. 

2 Navigate to Administration / Overview / Parallels Mac Management / Licenses. 

3 Right-click your site in the Licenses list and choose Activate license. 

4 The Parallels Mac Management - Activate License dialog opens. 

5 Input your license key and select the Activate offline option. 

6 Click Next. 

7 Click the Save button to save to offline activation request file. Specify a location and file name 
and click Save. Do not close the Parallels Mac Management - Activate License dialog. 

8 You now need to obtain the license activation file from Parallels My Account. To do so, visit 
https://account.parallels.com and sign in using your email address and password. 

9 Once signed in, click  next to your user name to open a side menu.  

10 In the side menu, expand the Parallels Mac Management section and click Offline Activation 
and Validation. 

11 On the Offline Activation and Validation page, submit the offline activation request file you 
saved earlier.  

12 Follow the instructions and download the license activation file. 

13 Go back to the Configuration Manager console. In the Parallels Mac Management - Activate 
License dialog, click Browse and select the license activation file you've obtained from 
Parallels My Account.  

14 Click Next. Your license information is displayed on the screen. Review the information and 
click Activate. 

15 On successful activation, the display value of the License status column in the Licenses list in 
the SCCM console changes to Activated. 

Your Parallels Mac Management installation is activated and the activation information is added to 
your Parallels My Account. 
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View and Update the License Information 

After you activate a Parallels Mac Management installation, you can view the license information in 
the Configuration Manager console. 

To view the license information: 

1 In the Configuration Manager console, navigate to Administration / Overview / Parallels Mac 
Management / Licenses. 

2 Right-click your site in the Licenses list and choose Properties. 

3 The Parallels Mac Management - License Information dialog opens where you can view the 
following information: 

• License key: The license key that was used to activate this installation. 

• Start date: The license key start date. 

• End date: The license key end date. 

• Number of licenses: The maximum number of Mac computers that can be managed in this 
installation. 

• Used licenses: The current number of managed Mac computers. 

• Remaining licenses: The number of licenses remaining. 

The license usage information is reported back to the Parallels Licensing Server automatically once 
a week. The information can then be viewed in Parallels My Account. This allows you to see the 
license usage info for all your Parallels Mac Management installations (if you have more than one) in 
one place.  

Note: If you activated Parallels Mac Management using the offline activation method, you need to 
synchronize the local license information with Parallels My Account using the offline refresh method as 
described in the following subsection. 

Refresh the license information 

The Refresh button on the  Parallels Mac Management - License Information dialog allows you 
to retrieve the current license information from the Parallels Licensing Server to reflect possible 
changes to your subscription. Normally, this update is done automatically every 24 hours if the 
server on which the Parallels Proxy is running has Internet access. By clicking the Refresh button, 
you can retrieve this information at any time.  This functionality is useful when, for example, you 
upgrade your subscription to have more licenses and want the licenses to become available in your 
Parallels Mac Management installation without waiting for the automatic refresh to happen. 

If the server on which Parallels Proxy is running has Internet access, simply click the Refresh 
button to update the license information. If the server has limited or no Internet access, read the 
following subsection. 
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Using the offline refresh method 

If the server hosting Parallels Proxy has limited or no Internet access, you must use the offline 
refresh method by following these steps: 

1 Click Refresh.  

2 If this Parallels Mac Management installation was activated using the offline method, you will 
first be asked to save the offline request file. 

3 After you save the file, you'll be asked to specify the file containing the latest subscription 
information. You must obtain this file from Parallels My Account. Don't close this dialog (you will 
return to it later). 

4 Visit https://account.parallels.com and sign in using your email address and 
password. 

5 Once signed in, click  next to your user name to open a side menu.  

6 In the side menu, expand the Parallels Mac Management section and click Offline Activation 
and Validation. 

7 On the Offline Activation and Validation page, specify the offline request file you saved earlier. 

8 Follow the instructions and download the subscription information file. 

9 Go back to the Configuration Manager console and select this file. 

10 Your local subscription information is updated with the latest information from the file you've 
obtained from Parallels My Account. 

 

Exceeding the License Limit 

Each Parallels Configuration Manager Proxy installed in an SCCM hierarchy constantly monitors the 
total number of Mac computers managed through it. If at any time the number of computers 
exceeds the license limit, the following happens: 

1 The information about the event is recorded to the Parallels Proxy log file. 

2 If an attempt is made to manually enroll a Mac in SCCM, an error message will be shown on 
the Mac during the registration procedure. 

3 All managed Mac computers will continue to be enrolled in SCCM and will retrieve their 
baselines normally. 

4 The Problem Monitor icon will indicate an error (will change its color to yellow) and will display a 
corresponding error message. The notification message (a balloon) will pop up in the Problem 
Monitor once an hour. 

5 Similar notification messages will be shown in the Configuration Manager console when you try 
to perform some of the administrative task, including: 

• Creating/editing Parallels Desktop and Virtual Machine configuration items. 

• Creating/editing Configuration Profiles. 
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• Creating/editing FileVault2 configuration items. 

• Pushing policies. 

What you can do when the license limit is exceeded 

If the license limit is exceeded, you can do the following: 

• To stop receiving alerts in the Configuration Manager console or the Problem Monitor, remove 
the excess Mac computers from SCCM. 

• If the Parallels Mac Management installation was activated using a sublicense, you can add 
more licenses to it in Parallels My Account. To do this, you must have unused licenses in the 
subscription. 

• If you used the master license key to activate Parallels Mac Management, then it means that 
you don't have any licenses left and need to upgrade your subscription (i.e. buy more licenses). 

 

Deactivating Parallels Mac Management 

You can deactivate a Parallels Mac Management installation and release the license key, so it can 
be used to activate Parallels Mac Management installed in another SCCM site. 

Depending on whether you activated Parallels Mac Management using the online or the offline 
activation method, the deactivation will be performed using the same method. 

To deactivate Parallels Mac Management: 

1 In the Configuration Manager console, navigate to Administration / Overview / Parallels Mac 
Management / Licenses. 

2 Right-click your site in the Licenses list and choose Properties. 

3 The Parallels Mac Management - License Information dialog opens. 

4 Click Deactivate. Depending on the original activation method, one of the following will 
happen: 

• Online activation: Parallels Mac Management connects to the Parallels Licensing Server and 
deactivates your Parallels Mac Management installation. You license key is released and you 
can use it to activate a different installation. If this is your case, you may stop reading here 
and skip the rest of this section. 

• Offline activation: Parallels Mac Management is deactivated, but the license key is not fully 
released. In order to complete the deactivation, you need to update the license key 
information on Parallels My Account. Follow the steps below to learn how to do it. 

5 You are asked to save the offline deactivation request file. Specify a location and file name and 
click Save. 

6 You now need to update your license information on Parallels My Account, so the license that 
you just released can be used to activate a different Parallels Mac Management installation. 
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Grant Administrative Privileges to a Local Mac User 

If you have Mac computers that are not members of a domain (or if you don't want to use a domain 
account for any reason), you need to create a local OS X user with administrative privileges. To add 
a user, open System Preferences > Users and Groups, click the plus-sign icon, select 
Administrator and specify the user information. Remember the user name and password as you 
will use it later to configure the client push installation. 

Enable SSH Access on a Mac 

Parallels Configuration Manager Proxy will connect to Mac computers over SSH, so you need to 
enable SSH access on each Mac. To do so: 

1 On a Mac, open System Preferences > Sharing. 

2 Enable the Remote login service. 

3 If you have granted permissions on this Mac to a domain account, add it to the list of users who 
are allowed remote access. If you'll be using a local user, add that user to the list. 

After enabling SSH access on a Mac and granting a local or a domain user SSH access, you 
should verify that you can actually establish an SSH connection. The Mac should allow SSH 
connection with password authentication. 

Using Multiple Accounts 

When creating local accounts or granting permissions to domain accounts on multiple Mac 
computers, you can set up the same account on all of them. This way you can configure Parallels 
Proxy to use the same account name and password to log into every Mac. However, if you want to 
use multiple accounts, you can do that too. For example, you can use one account on a certain 
group of Mac computers and another on a different group. Parallels Proxy will try every account 
that you configured, one by one, until a connection with a Mac can be established. Adding the 
account information to the push installation configuration is described later in this section.  
 

Configuring Parallels Mac Client Push Installation Properties 

Parallels Mac Client push installation properties must be configured, so that Parallels Proxy can 
push install Parallels Mac Client on discovered Mac computers. 

To configure push installation properties: 

1 In the Configuration Manager console, navigate to Administration / Site Configuration / Sites 
and select your SCCM site.  
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2 Click the Mac Client Push Installation toolbar item (or right-click on the site and choose 
Parallels Mac Client Push Installation). This opens the Parallels Mac Client Push 
Installation Properties dialog. 

 

3 On the General tab page, select the Enable automatic site-wide client push installation 
option. 

4 Specify one or more collections containing Mac computers to which you'll be push installing 
Parallels Mac Client. The Install client to all Mac OS X Systems option covers all Mac 
resources in every collection. The second option allows you to select one or more specific 
collections. 

5 Select the Accounts tab and then click the New icon to specify an account that will be used to 
push install Parallels Mac Client on discovered Mac computers. This can be a domain account 
or a local Mac account. See Enabling Remote Access on Mac Computers (p. 58) for the 
information on how to configure the accounts. 

6 Click OK to save the Parallels Mac Client push installation properties. 

Once the push installation properties are configured, Parallels Proxy will begin monitoring the 
system for discovered Mac computers. If you already have Mac resources in SCCM that don't have 
Parallels Mac Client installed, Parallels Proxy will identify these resources as Mac computers and 
will try to push install Parallels Mac Client on them. Newly discovered Mac computers will also be 
identified and the client will be push installed on them as well. The following sections describe how 
to configure and run Parallels Network Discovery and provides additional information about SCCM 
Active Directory System Discovery. 
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Using Parallels Network Discovery 

Parallels Network Discovery can discover Mac computers on your network and automatically push 
install Parallels Mac Client on them. Both domain joined and non-domain joined Mac computers 
can be discovered in one run. 
 

Configuring Parallels Network Discovery 

Before using Parallels Network Discovery to discover Mac computers and push install Parallels Mac 
Client on them, you need to configure it as described below: 

1 In the Configuration Manager console, navigate to Administration / Overview / Parallels Mac 
Management / Discovery Methods. The list in the right pane will be populated with one or 
more "Parallels Network Discovery" items according to the following conditions: 

• If you don't have secondary sites, the list will contain just one Parallels Network Discovery 
item. 

• If you have secondary sites, but Parallels Configuration Manager Proxy is installed only on 
the primary site, the list will contain just one item. 

• If you have secondary sites, and the Configuration Manager Proxy is installed on the primary 
and a secondary site, the list will contain one item for each site where the Proxy is installed. 

2 Right-click the Parallels Network Discovery item for the desired site and then select Properties. 
The Parallels Network Discovery properties dialog opens. 

General 

On the General tab page: 

1 Select the Enable network discovery option. 

2 Specify the TCP ports to scan (or use the default ports). Multiple ports can be separated by a 
comma, space, or semicolon. 

3 Select the Nmap timing policy from the drop-down list. The default Nmap settings provide the 
optimal balance between the quality of the results and the time it takes to scan the network. 

Accounts 

On the Accounts tab page, click the provided link to open the Parallels Mac Client Push 
Installation Properties dialog. If you haven't configured these properties yet, please refer to 
Configuration Parallels Mac Client Push Installation Properties (p. 59) for more information. 
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Running Parallels Network Discovery 

When Parallels Network Discovery runs, it will perform the following actions:  

1 When discovery finds a Mac, it will add it to SCCM as a resource and will continue searching 
the network. 

2 Parallels Proxy will then connect to the Mac over SSH and will push the Parallels Mac Client 
installation package to it.  

3 The installer will install Parallels Mac Client on the Mac and then enroll it in Configuration 
Manager.  

In a situation when a discovered Mac has Parallels Mac Client already installed, the following 
scenarios will be considered: 

• If the client is registered with a different Parallels Configuration Manager Proxy, but reports the 
same Configuration Manager site code as the current site, the client is re-registered with the 
current Configuration Manager Proxy and the Mac remains to be managed on the current site. 
This scenario may occur when you re-install the Configuration Manager Proxy on your 
Configuration Manager site (e.g. install in on a different computer).   

• If the client is registered with a different Parallels Configuration Manager Proxy and reports a 
different site code, the client registration will remain the same and the Mac will be ignored by 
Network Discovery. This situation may occur when a Mac computer (e.g. a laptop) is managed 
by Parallels Mac Management in one organization and is brought in to another organization that 
also uses Parallels Mac Management to manage their Mac computers. The site code 
comparison allows you to prevent a situation when a Mac is added by mistake to a wrong 
Configuration Manager site. 

The discovered Mac computers are placed into the All Mac OS X Systems collection. Please note 
that if you have secondary sites, Mac computers within their scope will be placed into the same All 
Mac OS X Systems collection on the primary site. For more information, see Collections in 
Parallels Mac Management (p. 76). 
 

Using SCCM Active Directory System Discovery 

SCCM AD System Discovery can discover domain-joined Mac computers. You can configure and 
run the AD System Discovery using the standard SCCM functionality. Once the Mac resources are 
discovered, Parallels Mac Management will automatically identify them as Mac computers and 
push install Parallels Mac Client on them. Active Directory specific properties will persist after the 
Parallels Mac Client installation and will be kept up-to-date by the scheduled runs of AD System 
Discovery.  

Note: Please note that for Parallels Mac Management to push install Parallels Mac Client on Mac 
computers discovered by AD System Discovery, the push installation properties must be configured as 
described in the Configuring Parallels Mac Client Push Installation Properties section (p. 59). 
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Running Parallels Mac Client Installer on a Mac 
This section describes how to manually install Parallels Mac Client on a Mac and enroll the Mac in 
Configuration Manager. 

First, you need to download the Parallels Mac Client installer to the Mac: 

1 Make sure that the Parallels Configuration Manager Proxy service is installed and running. 

2 Log into the computer running the Configuration Manager console.  

3 In the Configuration Manager console, navigate to Administration / Overview / Parallels Mac 
Management / Mac Client Enrollment. 

4 In the Mac Client Enrollment list, right-click the Mac Client installation package download 
URL item and then click Properties in the context menu. 

5 Copy the URL from the Mac Client Installer URL field and give it to the Mac user (e.g. email it). 
The URL will look similar to the following:  

http://myhost.local:8761/files/pma_agent.dmg 

6 The Mac user enters the URL into a Web browser to download the pma_agent.dmg image. 

To install Parallels Mac Client on the Mac: 

1 After the pma_agent.dmg download is complete, double-click it to open the image. 

2 In the Parallels Mac Management for Microsoft SCCM window, double-click the Parallels 
Mac Management for Microsoft SCCM.pkg icon. This will start the installation assistant. 

3 Follow the onscreen instructions. When asked, provide a user name and password. The user 
must be allowed to administer this Mac. 

4 When the installation is complete, click Close to exit the installation assistant. 

After you close the installation assistant, the Mac enrollment wizard will automatically open: 

1 Read the information provided on the Introduction page and then click Continue. 

2 On the Authorization page, enter your organization's domain name (e.g. 
Example.CompanyName.com), your domain username (e.g. UserName) and password. Please 
note that the username should contain the domain logon name only. It should NOT contain the 
domain name separated by a slash or the "@" sign. 

3 Click Continue. 

4 If you receive an error, click the Try Again button to return to the Authorization page and re-
enter the information. The registration may fail for the following reasons: 

• The specified domain name and/or domain credentials are incorrect. 

• The Mac IP address falls outside the boundary defined in Configuration Manager. 

• The Configuration Manager Proxy service is not running. 
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If you close the wizard without completing the enrollment, it will run automatically at predefined 
intervals (5-10 minutes) and every time you restart the Mac. To stop this from happening, either 
resolve the problem and enroll the Mac or uninstall Parallels Mac Client (p. 69). 

5 If firewall is enabled in OS X, a message will be displayed asking you if pma_agent.app 
should be allowed to accept incoming connections. Click Allow. This will add 
pma_agent.app to the firewall exception list. 

The results of a successful client registration should be as follows: 

• The Mac is enrolled in Configuration Manager. 

• The Mac inventory is collected and saved in the Configuration Manager. 

• The Mac is added to the All Mac OS X Systems collection in the Configuration Manager 
console. 

Once installed, Parallels Mac Client will run on a Mac in the background and will start automatically 
every time the Mac is restarted. 
 

Installing Parallels Mac Client Using a Script 
A special script is supplied with Parallels Mac Management that you can use to perform an 
unattended Parallels Mac Client installation.  

To obtain and use the script, follow these steps: 

1 On the computer running Parallels Configuration Manager Proxy, navigate to the C:\Program 
Files (x86)\Parallels\Parallels Mac Management for Microsoft 
SCCM\files directory. 

2 Locate the InstallAgentUnattended.sh file and copy it to a Mac. Copy the file to a Mac. 
Alternately, you can use Apple Remote Desktop to run the script on a Mac remotely. 

3 Please note that you must use sudo to run the script because enrolling a Mac in Configuration 
Manager requires superuser privileges. 

When you run the script, provide the following parameters (in the order listed): 

• agent_download_url — the URL of the Parallels Mac Client installer. The URL can be 
obtained in the Configuration Manager console as described in Manually Installing 
Parallels Mac Client. 

• user_name — specifies the name of a domain user account that will be used to register 
Parallels Mac Client with the Configuration Manager Proxy. Please note that that the name 
must contain the domain logon name (e.g. UserName). It must NOT contain a domain name 
separated by a slash or an at (@) sign. 

• user_password — the domain user password.   

• domain_name — your company's domain name. 
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Verifying Parallels Mac Client Deployment 
To verify that the Parallels Mac Management deployment was successful, open the Configuration 
Manager console and navigate to Assets and Collections / Devices / All Mac OS X Systems. 
You should see some Mac computers in the list. If you ran Parallels Network Discovery to discover 
Mac computers, some of those Mac computers may not have Parallels Mac Client installed on 
them. The possible reasons for this are described in Using Parallels Network Discovery (p. 61).  

To see if a Mac has Parallels Mac Client installed and running on it, look at the Client and Client 
Activity properties, which should say "Yes" and "Active" respectively. If the Client property says 
"No", it means that the Mac cannot be managed in SCCM because Parallels Mac Client is not 
installed on it. If the Client Activity property says "Inactive", the Mac may be turned off, 
disconnected from the network, or it may have some other issues that prevent the Configuration 
Manager to communicate with it. 
 

Updating Parallels Proxy Connection URL 
If you migrate Parallels Configuration Manager Proxy to a different server, its connection URL 
record must be updated on managed Mac computers. Parallels Mac Client is capable of making 
this update automatically as described below. 

Parallels Mac Client running on a Mac connects to the Parallels Configuration Manager Proxy using 
the connection URL that it obtains from the Active Directory during the Parallels Mac Client 
installation. If at some point the client fails to establish a connection with the proxy, it will try to 
recover the connection as follows: 

1 First, it will try to access DNS records for the location of the Configuration Manager Proxy. If it 
finds the new connection URL in DNS, it will use it to connect to the Configuration Manager 
Proxy. 

2 If the location cannot be found in DNS at this time, the client will keep trying to connect to the 
Proxy and to find the new location in DNS for a period of one week.  

3 If after a week the connection still cannot be establish, a dialog box will be displayed in OS X 
asking the Mac user to enter the Active Directory credentials. The client will then connect to the 
Active Directory and try to retrieve the Configuration Manager Proxy connection URL from it. If 
succeeded, the client will use the URL to connect to the Configuration Manager Proxy. If it fails 
again, it will display an error message to the Mac user advising them to contact the system 
administrator. 

For additional information about migrating the Configuration Manager proxy to a different server, 
please see Migrating Configuration Manager Proxy (p. 41). 
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Uninstalling Parallels Mac Client 
To uninstall Parallels Mac Client from a Mac, execute the following command in Terminal: 
$ sudo /bin/bash –с 
/Library/Parallels/pma_agent.app/Contents/MacOS/pma_agent_uninstaller.app/Contents/Reso
urces/UninstallAgentScript.sh 

You can also run the Parallels Mac Client uninstaller in interactive mode as follows: 

1 Open Finder and choose Go > Go to Folder.  

2 Type /Library and click Go. 

3 Locate and open the Parallels folder. 

4 In the Parallels folder, right-click the pma_agent.app file and click Show Package Contents 
in the context menu. 

5 Open the Contents/MacOS folder.  

6 Double-click the pma_agent_uninstaller.app file to start the uninstaller. 

7 Follow the onscreen instructions to uninstall Parallels Mac Client. 

After Parallels Mac Client is uninstalled, the Mac will remain in the Configuration Manager database 
but its management will not be possible. You can reinstall the client on the Mac later to restore 
management functions. 
 

Upgrading Parallels Mac Client 
When you upgrade Parallels Mac Management for Microsoft SCCM, you also need to upgrade 
Parallels Mac Client on every Mac computer on which it is installed. This task can be accomplished 
using one of the following methods: 

1 Enabling the Automatic Parallels Mac Client Update option in the Configuration Manager 
console. This will upgrade Parallels Mac Client on every managed Mac automatically without 
requiring the administrator to take any extra steps. 

2 Distributing the client installation package to Mac computers using the standard SCCM 
software distribution functionality. 

3 Manually uninstalling Parallels Mac Client from a Mac and then installing a new version. 

Each method is described in detail in the following subsections. 
 

Automatic Upgrade of Parallels Mac Client 

Parallels Mac Client can be upgraded automatically when you upgrade Parallels Mac Management 
to a newer version. 
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To use this functionality, the Automatic Parallels Mac Client Upgrade option must be enabled in 
the Configuration Manager console as described below: 

1 Navigate to Administration / Site Configuration / Sites.  

2 Right-click the Sites node and choose Hierarchy Settings. The Hierarchy Settings 
Properties dialog opens. 

 

3 Click the Automatic Mac Client Upgrade tab and select the Upgrade client automatically 
when new client updates are available option.  

After you enable this option, Parallels Mac Client running on a Mac will begin to periodically check 
whether it needs to be upgraded. If you upgrade Parallels Mac Management to a newer version 
while this option is enabled (or prior to enabling it), Parallels Mac Client will be automatically 
upgraded on all managed Mac computers. The Parallels Mac Client registration parameters will be 
inherited from the existing registration file, so you don't have to configure it again. 

Note: It may take up to an hour (or more) for Mac computers to upgrade after Parallels Mac 
Management is upgraded. 

 

Upgrading Parallels Mac Client via Software Distribution 

To upgrade Parallels Mac Client on Mac computers via Software Distribution, do the following: 

1 Obtain the Parallels Mac Client installation image file as described in Manually Installing 
Parallels Mac Client.  
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2 Distribute the client installation image to Mac computers. The Deploying Software via SCCM 
Package Deployment section (p. 112) describes how to accomplish this task.  

Note that when creating a program for the distribution package, the Command Line property 
should be specified as follows: 

:pma_agent.dmg/Parallels Mac Management for Microsoft SCCM.pkg:: 

When you install Parallels Mac Client via software distribution, the client registration parameters will 
be inherited from the existing registration file, so you don't have to configure the client again.  
 

Manually Upgrading Parallels Mac Client 

If you need to upgrade Parallels Mac Client on a single Mac, you can do it manually as follows: 

1 Uninstall Parallels Mac Client from a Mac. See Uninstalling Parallels Mac Client (p. 69). This is 
a necessary step. Please note that when upgrading Parallels Mac Client using the automatic 
upgrade option or the software distribution functionality (described above), the client is 
uninstalled automatically. 

2 Download the Parallels Mac Client installation image and run the installation program as 
described in Manually Installing Parallels Mac Client. 

 

Using Parallels Mac Client Tools 
Parallels Mac Client includes useful tools that can be run from System Preferences. This chapter 
describes how to use them. 
 

Viewing Parallels Mac Client Properties 

The Parallels Mac Client properties window allows you to see the Mac Client properties, send a 
problem report, and retrieve policies from Configuration Manager. 

To open the Parallels Mac Client properties window: 

1 In OS X, open System Preferences. 
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2 Click the Parallels Mac Management icon (or click VIew > Parallels Mac Management for 
Microsoft SCCM). 

 

3 The client properties window opens. 

 

4 The General box contains the following Parallels Mac Client properties: 

• Certificate expiration date. The date and time when the Parallels Mac Client certificate 
expires. 

• Certificate subject name. A globally unique name identifying the Parallels Mac Client for 
which the certificate was issued. 

• Connected to SCCM Proxy. The last date and time the Parallels Mac Client established a 
connection with the Parallels Configuration Manager Proxy. 
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• Policies received. The last time the Parallels Mac Client downloaded its policy. 

• SCCM Proxy URL. The URL of the computer where the Parallels Configuration Manager 
Proxy is running. This is the Parallels Configuration Manager Proxy with which this Parallels 
Mac Client is registered. 

• Site code. The code of the Configuration Manager site to which this Mac is assigned. 

• Unique identifier. A globally unique ID assigned to this Parallels Mac Client instance. 

• Version. The Parallels Mac Client version number. 

5 The buttons at the bottom of the window are: 

• Connect. When clicked, connects to the Parallels Configuration Manager Proxy and 
downloads the latest policy from Configuration Manager. For more information, please see 
Initiating Policy Retrieval below. 

• Send Problem Report. Click this button to send a problem report to Parallels Support. For 
more information, please see Sending Problem Reports from Parallels Mac Client below. 

 

Initiating Policy Retrieval from a Mac 

Parallels Mac Client downloads its policy from Configuration Manager on a schedule. There may be 
a need to download the latest policy before the scheduled download occurs. Parallels Mac Client 
provides you with this ability. 

Using the Client Properties Dialog to Initiate Policy Retrieval 

To initiate policy retrieval: 

1 In System Preferences, click the Parallels Mac Management icon (or click VIew > Parallels 
Mac Management for Microsoft SCCM). 

2 Click the Connect button to initiate policy retrieval. A text will appear next to the button 
informing you of the progress.  

3 If the connection to Configuration Manager was successful, the text will say "Connected" and 
will specify how many policy updates have been received.  

4 The Policies received property in the General list box will be updated if at least one update 
has been received. The property will remain unchanged if no updates are available. 

Initiate Policy Retrieval from the Command Line 

To initiate policy retrieval from the command line, open Terminal, change directory to 
/Library/Parallels/pma_agent.app/Contents/MacOS and type the following 
command: 
$ ./pmmctl get-policies 

On completion, the command returns one of the following XML documents depending on the 
result. 
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If policy retrieval failed: 
<plist version="1.0"> 
    <dict> 
        <key>ErrorCode</key> 
        <integer>3</integer> 
        <key>ErrorMessage</key> 
        <string>Operation timed out</string> 
    </dict> 
</plist> 

where the <integer> element contains the error code, and the <string> element contains the 
error description.  

If policy retrieval was successful: 
<plist version="1.0"> 
    <dict> 
        <key>ErrorCode</key> 
        <integer>0</integer> 
        <key>ErrorMessage</key> 
        <string>No error</string> 
 <key>NumberOfPolicyUpdates</key> 
 <integer>5</integer> 
    </dict> 
</plist> 

where the <integer> value of the <NumberOfPolicyUpdates> key contains the number of 
policy updates retrieved. 

To obtain the list of possible error codes with descriptions, use the following command: 
$ pmmctl error-info 

The command returns the following list: 
0: No error 
1: Invalid command 
2: Operation failed 
3: Operation timed out 
4: Connection aborted 
5: Unknown error code 5 
 

Sending Problem Reports From Parallels Mac Client 

If you are experiencing a problem with Parallels Mac Client, you can obtain a problem report and 
then send it to Parallels Support. To obtain a report: 

1 In System Preferences, click the Parallels Mac Management icon (or click VIew > Parallels 
Mac Management for Microsoft SCCM). 

2 Click the Send Problem Report button to obtain a report. The Send Problem Report dialog 
opens and the report data gathering process begins.  
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3 Once the report file is generated, a message is displayed in the dialog specifying its location on 
the local hard drive. Clicking the Send button will send the report to the Parallels Configuration 
Manager Proxy, which will notify the IT administrator through the Problem Monitoring utility. The 
Problem Monitor can then be used to view the report summary and to send it to Parallels 
Support. 

The problem reporting utility can also be run from Finder as follows: 

1 Open Finder and navigate to the /Library/Parallels/ folder.  

2 Locate the pma_agent.app package, right-click it and select Show Package Contents.  

3 In the package, navigate to the Contents/MacOS folder and double-click the 
pma_report_tool file.  

4 The Send Problem Report dialog opens. This is the same dialog as the one that opens when 
you click the Send Problem Report button described above. 
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• Description — specifies whether the report was generated automatically or manually by a user. 

If there are no problem reports on the server, the list will be empty. 

To perform an action on a report, select the report of interest from the list and click one of the 
available buttons: 

• Click Send to send the selected problem report to Parallels Support. After the report is sent, it 
is removed from the server on which it resides. 

• Click Delete  to delete the selected report from the list and the server on which it resides. 

• Click Close to closes the dialog. The reports will remain in the problem monitor report list and 
the report files will remain in their original locations. 

Viewing the Problem Report Activity Log 

The problem monitor maintains an activity log, which contains the information about the operations 
that were performed on the reports. To view the problem report activity log, right-click the problem 
monitor icon in the notification area and select Problem Reports Log from the context menu. The 
Problem Report Operations Log dialog opens. Each entry in the log describes an individual 
operation that was performed on a report. This is a read-only information provided as a reference. If 
a report operation included sending it to Parallels Support, the entry will include the report ID, which 
can be used when following up on the report with Parallels Support. 
 

Initiating Policy Retrieval from SCCM 
Managed Mac computers download client policies from Configuration Manager automatically 
according to a schedule. There may be a need to download the latest policy before the scheduled 
download occurs. This is especially helpful when you test or debug something. Policy retrieval can 
be done from an individual Mac computer as described in the Initiating Policy Retrieval from a 
Mac section (p. 73). The functionality described here allows you to initiate policy retrieval for 
multiple Mac computers from the Configuration Manager console. 

To initiate policy retrieval from the Configuration Manager console:  

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Device Collections.  

2 You can initiate policy retrieval for the entire collection or for selected Mac computers: 

• To select individual Mac computers, double-click the collection containing your Mac 
computers and then select the desired computers. 

• To initiate policy retrieval for the entire collection, simply select the collection without 
opening it (alternately, you can navigate to Overview / Devices and select the collection in 
the left pane). 
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While the collection or individual Mac computers are selected, right-click on them and then click 
Parallels Management Tools > Machine Policy Retrieval and Evaluation Cycle in the 
context menu. 

3 The Requesting Mac Clients to Download Policies dialog opens and the policy retrieval 
initiation operation begins automatically. The progress bar informs you of how many Mac 
computers have been processed.  

4 While the operation is in progress, you can hide the dialog by clicking the Hide button or by 
simply closing the dialog. The policy retrieval operation will continue to run in the background. If 
you want to cancel the operation, click Cancel. 

5 You can initiate another policy retrieval operation while the current operation is still in progress. 
To do so, simply repeat the steps above. Additional Mac computers that you select this time will 
be added to the list of the currently processed Mac computers and the operation will continue 
uninterrupted. 

6 When all Mac computers are processed, you can view the results of the operation by clicking 
the Details button. If the button is disabled, it means that all Mac computers were processed 
successfully. This means that the policy retrieval operation has been initiated on all selected 
Mac computers. If the button is enabled, clicking it displays the list of Mac computers that the 
Parallels Configuration Manager Proxy was unable to connect to. The Status column of the list 
will contain one of the following:  

• Offline — the Mac is turned off or unreachable. 

• Connection refused — the Mac was reachable but the connection was refused by it. 

• No client installed — the Mac doesn't have the Parallels Mac Client installed on it. 

• Not a Mac — the resource is not a Mac computer. 

You can sort the list by Resource Name or Status by clicking the corresponding column 
header. 
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Logging 
Parallels Mac Management maintains its own log files which capture information about its 
processes. The log files are created and maintained for each component including Parallels 
Configuration Manager Proxy, Configuration Manager Console Extension, and clients running on 
individual Mac computers. Some information about Parallels Mac Management processes is also 
recorded in the System Center Configuration Manager log files. You can use the information 
contained in the log files to help you troubleshoot issues that might occur in the Parallels Mac 
Management for Microsoft SCCM.  

Parallels Mac Management for Microsoft SCCM Log Files 

The Parallels Mac Management log files are located in the following directories: 

• Windows computer running Parallels Configuration Manager Proxy: %Windir%\Logs ; 
%Windir%\Logs\pmm 

• Windows computer running Parallels OS X Software Update Point: %Windir%\Logs\pmm 

• Windows computer running Configuration Manager console: %Windir%\Logs 

• OS X (Parallels Mac Client): /Library/Logs/ 

The following table describes the Parallels Mac Management for Microsoft SCCM log files: 

Component Log File Name Log File Description 

Parallels Configuration 
Manager Proxy 

pma_setup.log This log file is created during the SCCM Proxy 
installation. It contains information about the 
installation procedures and the changes they 
make to the system.  

Please note that when the SCCM Proxy and 
the SCCM Console Extension components 
are installed on the same computer, the 
pma_setup.log is shared between them. 

C H A P T E R  6  

Appendices 
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pma_isv_proxy_config.log This log file is created and updated every time 
the SCCM Proxy configuration utility is run. It 
contains information about the configuration 
parameters selected by the user (SMS 
Provider, service account name, etc.) and the 
results of the configuration operations. 

pma_isv_proxy_service.log This is the main SCCM Proxy log file. It is 
updated as needed while the SCCM Proxy 
service is running. It contains information 
related to the SCCM Proxy operations such 
as starting/stopping the service, reading 
various system properties, starting or 
stopping Mac management utilities and 
others.  

pma_discovery.log This log file is updated every time the Parallels 
Network Discovery runs. It contains 
information about the discovery itself 
(processes started, subnets searched, etc) 
and the information about discovered Mac 
computers, including IP address, hostname, 
MAC address, whether the Client installation 
was initiated on a Mac, and other info. 

pmm_cep_master_service.log This log file belongs to the Parallels Customer 
Experience Program module. The log is 
updated when the corresponding service 
collects information and generates reports 
about the system. 

Parallels OS X Software 
Update Point 

pmm_sup_service.log This log file belong to the Parallels OS X 
Software Update Point component. it is 
updated when the corresponding service 
performs any of its operations. 

SCCM Console Extension pma_setup.log The SCCM Console Extension component 
has just one log file: pma_setup.log. The file 
contains information about the component 
installation procedure.  

Please note that when the SCCM Proxy and 
the SCCM Console Extension components 
are installed on the same computer, the 
pma_setup.log is shared between them. 

Parallels Mac Client 

 

pma_agent.log This is the main client software log file, which 
contains information about the client 
operations. The file is updated when the Mac 
Client communicates with SCCM Proxy 
and/or performs actions on the Mac 
computer on which it is running. 
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pma_agent_ui.log This log file is updated when the client 
installation and registration utilities are run on 
the Mac by a user.  

The file also records information when an 
operation is performed on the Mac that is 
user-specific. An example of such an 
operation is applying a Mac configuration 
profile (a profile is applied for each individual 
Mac user if more than one user exists). 

Please note that if a Mac user doesn't have 
privileges to write to the /Library/Logs 
directory, the log file will be created in the 
/Users/<user_name>/Library/Logs directory. 

pma_agent_uninstaller.log This log file is created when the client is 
uninstalled from the Mac computer. 

System Center Configuration Manager Log Files 

Some of the Parallels Mac Management process information is recorded in the SCCM log files. You 
may examine these files in addition to the log files described above. Please note that SCCM creates 
these files on the fly and not all of them may actually exist. 

The following table describes the Site Server log files which are located in the 
<SCCM_InstallationPath>\LOGS folder. The files may contain information about the SCCM 
Proxy component.  

Log file Log file description 

Colleval.log Records activities when collections are created, changed, and deleted by the 
Collection Evaluator. 

Dataldr.log Processes Management Information Format (MIF) files and hardware inventory in 
the Configuration Manager database. 

Ddm.log Saves DDR information to the Configuration Manager database by the Discovery 
Data Manager. 

Distmgr.log Records package creation, compression, delta replication, and information 
updates. 

Offermgr.log Records advertisement updates. 

Offersum.log Records summarization of advertisement status messages. 

Policypv.log Records updates to the client policies to reflect changes to client settings or 
advertisements. 

Smsprov.log Records WMI provider access to the site database. 

statesys.log  Records the processing of state system messages. 

The following table describes the Management Point log files, which are located in the 
%ProgramFiles%\SMS_CCM\Logs folder. The files may contain information about the SCCM 
Proxy component. 

Log file Log file description 

MP_CliReg.log Records the client registration activity processed by the management point. 
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MP_Ddr.log Records the conversion of XML.ddr records from clients, and copies them to the 
site server. 

MP_Framework.log Records the activities of the core management point and client framework 
components. 

MP_GetAuth.log Records the status of the site management points. 

MP_GetPolicy.log Records policy information. 

MP_Hinv.log  Converts XML hardware inventory records from clients and copies the files to the 
site server. 

MP_Location.log Records location manager tasks. 

MP_OOBMgr.log Records the management point activities related to receiving OTP form a client. 

MP_Policy.log Records policy communication. 

MP_Relay.log  Copies files that are collected from the client. 

MP_Retry.log Records the hardware inventory retry processes. 

MP_Sinv.log Converts XML software inventory records from clients and copies them to the site 
server. 

MP_SinvCollFile.log Records details about file collection. 

MP_Status.log Converts XML.svf status message files from clients and copies them to the site 
server. 

The following table describes the Admin UI log files, which are located in the 
<SCCM_InstallationPath>\AdminUI\AdminUILog directory. The files may contain 
information about the Configuration Manager Console Extension component. 

Log file Log file description 

ResourceExplorer.log Records errors, warnings, and information about running the Resource Explorer.  

SMSAdminUI.log  Records the local Configuration Manager console tasks when you connect to the 
Configuration Manager site. 

Parallels Mac Management for Microsoft SCCM Crash Dumps 

In addition to log files, crash dumps may be generated if a Parallels Mac Management component 
terminates abnormally. The crash dumps are generated for the Configuration Manager Proxy 
component and for Parallels Mac Clients running on individual Macs. Please note that crash dumps 
may not be created every time a component crashes. If a dump doesn't exist in the directories 
specified below, it can be found in the problem report, which will be generated instead. 

The crash dump file locations are: 

• Parallels Configuration Manager Proxy: 
%ALLUSERSPROFILE%\Microsoft\Windows\WER\ReportQueue\AppCrash_pma_isv
_proxy_*, where AppCrash_pma_isv_proxy_* is the name of a directory containing the 
crash dump files (the name is appended with a unique suffix for each dump). 

• Parallels Mac Client: /Library/Logs/CrashReporter/pma_agent*.crash, where 
pma_agent*.crash is the name of the directory containing the files (the asterisk character is 
substituted with a unique dump identifier). 
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Changing Log File Rotation Limits 

About Log File Rotation 

Parallels Mac Management for Microsoft SCCM implements log file rotation that ensures that the 
log files don't grow in size indefinitely. The amount of data contained in an individual log file and the 
total size of all logs are kept at a reasonable limit. Log file rotation is enabled by default.  

Parallels Mac Management for Microsoft SCCM consists of a number of executables including 
services, graphical user interface, and utilities. Each executable creates its own log file named 
<exec_name.log>, where "exec_name" is the executable file name. The following table lists 
Parallels Mac Management executables and their corresponding log file names and locations: 

Executable Name Operating System Log File Name and Path 

pma_isv_proxy_service Windows %Windir%\Logs\pma_isv_proxy_service.log 

pma_isv_proxy_config Windows %Windir%\Logs\pma_isv_proxy_config.log 

pma_discovery Windows %Windir%\Logs\pma_discovery.log 

pmm_cep_master_service Windows %Windir%\Logs\pmm\pmm_cep_master_service.log 

pmm_sup_service Windows %Windir%\Logs\pmm\pmm_sup_service.log 

pma_problem_monitor Windows %Windir%\Logs\pma_problem_monitor.log 

pma_report_tool 
Windows 

OS X 

%Windir%\Logs\pma_report_tool.log 

/Users/<user_name>/Library/Logs 

pma_agent OS X  /Library/Logs/pma_agent.log 

pma_agent_ui OS X /Library/Logs/pma_agent_ui.log 

A log file is populated with data when an executable is running and performing its tasks. When the 
size of a log file exceeds a predefined limit, the file is archived and a new empty log file is created in 
its place. This creates a log file rotation set consisting of the current log file and archived files. A log 
file rotation set is managed using the following rules: 

• Log files are archived using the zlib compression library. 

• The archived files in the set are named as follows:  

<exec_name.1.log.gz>, <exec_name.2.log.gz>, <exec_name.3.log.gz>, etc.  

The <exec_name.1.log.gz> file is the most recently archived log segment. The file with the 
largest sequential number in its name is the oldest. When the current log file is archived, it is 
named <exec_name.1.log.gz>. The existing archives are renamed by incrementing the 
sequential number in their names by 1. The maximum number of files in a rotation set can be 
configured (see Changing Log File Rotation Limits below). When the number of files exceeds 
the predefined limit, the oldest file is deleted. 

• Rotation of each log is performed independently from other logs. 
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Changing Log File Rotation Limits 

Log file rotation limits are configured similarly on both Windows and OS X computers. The following 
rules apply when specifying the limits: 

• Log file size limit. The default value is 1 MB (specified in bytes). The minimum allowed value is 
200 KB. The maximum allowed value is 4 MB. If a value is not set, the default value is used. If 
the specified value falls outside the min/max interval, the minimum or the maximum value is 
used respectively. 

• Maximum number of files in a rotation set. The default value is 10. The minimum value is 1. 
The maximum value is 20. If a value is not set, the default value is used. If the specified value 
falls outside the min/max interval, the minimum or the maximum value is used respectively.  

On Windows computers the log rotation limits are stored in the system registry. To modify the 
limits: 

• Run "regedit" and search for HKEY_LOCAL_MACHINE\SOFTWARE\Parallels\Parallels 
Management Suite for Microsoft SCCM\Preferences. 

• To set the log file size limit, modify the value of the "LogFileSizeLimit" parameter. The size is 
specified in bytes. 

• To set the maximum number of files in a rotation set, modify the value of the 
“MaxNumberOfSavedLogs” parameter.  

On OS X computers, the log rotation limits are stored in the 
/Library/Preferences/com.parallels.pma.agent.plist file. To modify the limits: 

• Open the com.parallels.pma.agent.plist file in a text editor. 

• To set the log file size limit, modify the value of the "LogFileSizeLimit" parameter. The size is 
specified in bytes. 

• To set the maximum number of files in a rotation set, modify the value of the 
“MaxNumberOfSavedLogs” parameter. 

 

Parallels Mac Management Database 
When Parallels Mac Management for Microsoft SCCM is installed, it creates its own SQL Server 
database on the primary SCCM site to store security data such as recovery keys, certificates, and 
other.  

The database name is constructed using the following syntax: 

PMM_<site_name> 

Where, PMM_ is used as-is and <site_name> is the name of the primary SCCM site. 
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At the time of this writing, the database is used to store the FileVault 2 disk encryption information 
and recovery keys. Other security related data may be stored in the database in the future. 

The system administrator should backup the database regularly in order to ensure the data safety. 
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